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Summary
Discover a range of efficient and user-friendly PDF conversion tools in this article. Regardless of your operating system, convert PDF to PNG effortlessly.
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I. PDF and PNG



 


 Before introducing the conversion of PDF to PNG images, we can first understand what they are and what are their characteristics.


 PDF


 PDF (Portable Document Format) is the industry standard for document sharing because it creates an exact copy of any file to be copied, including image files. Data such as text, pictures, tables, or videos can be saved in a PDF document, which can completely and accurately display the layout and content of the original document.


 Main features of PDF documents:	reliability. Documents used as PDFs are guaranteed to be identical to the original document or image when viewed as a copy of the image file. Whether you view it on a computer or a mobile phone, it will not change due to device changes, and always maintain the correct display of graphics or text content.
	high quality. PDF objects (especially images) can be highly compressed using different compression algorithms without quality loss. When you need to print a document, PDF is the best choice.





 PNG


 PNG file is an open format without copyright restrictions, and is the most commonly used lossless image compression file format on the Internet. Among other things, PNG files can also contain 24-bit RGB color palettes and grayscale images. This format is ideal for creating web graphics, logos, illustrations, and more. The biggest advantage of PNG is that it supports image transparency, allowing you to easily place illustrations or graphics on colored backgrounds. If the image needs to be edited and saved multiple times, it is recommended that you use the PNG format.


 Key features of PNG images:	The file size is large. Unlike images such as JPG, which are compressed in the same way, PNG format files are relatively large compared to JPG images.
	Lossless image quality. The LZW compression used when creating PNGs causes no quality loss, so images can be edited, saved again and again, without performance degradation over time.





 Both PDF and PNG have their own characteristics and advantages, and how to use them depends on your actual needs. If you need to convert PDF to PNG losslessly, you can use various methods described below.





II. Introduction to PDF conversion software: Quickly convert PDF documents to PNG



 Using professional PDF conversion software can quickly help you convert various document or image formats, which can save a lot of time. Usually professional PDF conversion software can provide a variety of functions, not only the conversion function, but also other editing functions. There are many choices of PDF software, the following will select several common PDF conversion software for you, and introduce the operation steps of converting PDF to PNG image in detail.


1. Renee PDF Aide



 Renee PDF Aide , easy to operate, the conversion rate is as high as 80 pages per minute, and supports conversion into various image formats, such as JPG, PNG, BMP, GIF and TIFF formats. In addition to being able to convert to image formats, it also supports conversion to Word, Excel, PowerPoint, ePub, Text, and HTML formats. This software is a PDF conversion software that integrates multiple functions. In addition to format conversion, you can also edit, optimize, repair, and encrypt PDF files. Although the functions are diverse, the operation interface is simple and the actual operation is very simple.


 Supported operating systems: Windows 10/8.1/8/7/Vista/XP/2000 (32-bit and 64-bit versions).
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The specific operation steps are as follows:



 ① After installing Renee PDF Aide , open it. Then, select (Convert PDF).


 


 ② Select (Image) in the upper menu bar, and then set the output image resolution and PNG image format.


 


 ③ Click the (Add File) button to open the PDF file to be converted. After the file is successfully added, the information of the file to be converted will be displayed in the conversion list, and the page for file conversion can be set by clicking the (select page) list.


 


 ④ Click the (Convert) button to convert. When the conversion is over, the software will prompt the total number of converted files and the number of successfully converted files. At this time, the PDF file has been successfully converted into an image.


tipsAs an extra tip, if you also need to convert PNG images to PDF files, you can also convert them through Renee PDF Aide.The specific operation steps are as follows:
① Open Renee PDF Aide, click (PDF toolset).
 ② Click (Add File) to import the picture into the software.
 ③ Click (Image to PDF) in the upper menu bar, and then select (Merge to one file) or (One image to one PDF file).
Description of image conversion settings:
	Merge into one file: Generate all added pictures into one PDF file, and one page of PDF will be generated for one picture.
	One image and one PDF file: generate a PDF file for all the added images and one image.


④ Finally, select the location to save the file and click (Convert).





2. Adobe Acrobat DC



 Adobe Acrobat DC is an electronic word processing software set developed by Adobe, which can be used to read, edit, manage and share PDF documents. Use this software to convert everything stored in a PDF to a PNG image, and also keep fonts and typography intact, including bullets and tables. Adobe Acrobat DC is a cross-platform support for Windows, Mac, Linux, Android phones and Windows Phone. This allows you to view and manage PDF files on your phone and computer. Although Adobe Acrobat DC can provide a good format conversion function, its purchase price will be much higher than other software. The following is an introduction to the steps of using Adobe Acrobat DC to convert PDF documents to PNG images.


The specific operation steps are as follows:



 ① Open the PDF file in Adobe Acrobat DC. On the toolbar on the right, choose (Export PDF).


 


 ② Click (Image)>(PNG). If you need to set the output quality of the PNG image, please click the (Settings) icon next to PNG to change the file, color and conversion settings, and click (OK) to return after setting. Then click (Export). In addition, you can check (Export all images) to export each image in the PDF as a separate image file, and uncheck it if you do not want to export pictures separately.


 


 ③ In the opened Save As window, you can choose the location to save the picture and enter the file name, and finally click (Save).


3. Preview (macOS)



 On a Mac computer, you don’t need to install additional image viewing tools, screenshot tools or PDF reading editors, because the preview application is enough. Preview is a Mac’s built-in application that quickly converts PDF files to PNG images. The program supports converting PDF to PNG, JPG, and TIFF image formats. In addition to converting PDF to PNG, the preview application also provides other simple PDF editing and image editing functions. It should be noted that the preview can only convert one page of the document at a time when converting the image. If your PDF document has multiple pages, you need to do more operations.


The specific operation steps are as follows:



 ① Open the PDF file in Preview. Then, select the pages you want to convert to PDF, and click (File) > (Export).


 


 ② In the opened dialog box, select (PNG) from the Format drop-down menu. After setting the resolution and pixels for the picture, click (Save) to complete the conversion.


 


4. DocuFreezer



 If you need to convert multiple PDF files to PNG format, then DocuFreezer software is a good choice. The software is easy to use and can convert dozens or even hundreds of PDF documents at one time. In addition to converting PDF, this software also supports converting other file formats, such as Word, Excel, PowerPoint, TXT, XPS, AutoCAD, SolidWorks, Solid Edge, etc. DocuFreezer software will help you convert almost any document to PDF, JPG, PNG, TIFF, TXT. In addition, DocuFreezer also supports OCR text recognition function, which can recognize text and save the file to searchable PDF or TXT.


The specific operation steps are as follows:



 ① Install and open the DocuFreezer software, then drag and drop the PDF document to be converted into the software window.


 ② Select (PNG) in the Output file type (output file format), and set the folder for saving the output file. Finally click the (Start) button to execute the format conversion command.


 


5. Pixillion Image Converter



 Pixillion Image Converter is an easy-to-use file converter that converts PDF to different file formats such as JPG, PNG, GIF, NEF, ICO, RAW, HEIC and other image formats. The software supports one-click batch conversion, and its batch processing function can help users batch convert several or even thousands of files at one time, saving us the trouble of operating one by one. And it can also rotate, resize and compress digital photos, preview your images fully and format information, in addition to easily add subtitles or watermarks to converted pictures.


The specific operation steps are as follows:



 ① Download, install and run Pixillion Image Converter software, then click (Add file(s)) to import the PDF file to be converted.


 ② Select the (PNG) format to be converted in the Output Format at the bottom of the software, and set the folder location to save the image in the Output Folder. Finally, click (Convert).


 


III. Online conversion method of PDF to PNG



 In addition to downloading a professional PDF conversion tool, you can also convert PDF to PNG format through online conversion tools. No software download required and works on any operating system. Despite the promise of a free and accessible PDF conversion platform, online PDF conversion programs can pose risks and inconveniences to users. There is always a risk of information being stolen because whenever you upload a file to someone else’s website, that file is saved on the server for retrieval and access by the other party. This puts your data and information at risk of theft by criminals. Also, since the online conversion tool is web-based, you need an internet connection to access it. The online conversion method is not recommended if you have an unstable or problematic network.


1. PDF to PNG



 PDF to PNG is a completely free online conversion tool to convert PDF documents to any other format. In addition to converting PDF to PNG format, you can also convert it to DOC, DOCX, TXT, JPG, SVG and other formats, and you can also merge, compress, and split PDF files.


 Online conversion link: https://pdf2png.com/zh/


The specific operation steps are as follows:



 ① Open the conversion link on the browser, click (Upload Document), and upload the PDF file to be converted. You can upload multiple PDF files at the same time.


 ② Wait for the conversion to complete after uploading, click (Download) or (Download All) to download the PNG image to the computer.


 


2. PDF Converter



 PDF Converter is an online conversion tool that supports mutual conversion between PDF and PNG, JPG, Word, Excel, PowerPoint and other formats. The conversion operation of this tool is very simple, you can easily convert PDF to PNG format. In addition, it also supports merging, splitting, compressing, rotating PDF pages, etc.


 Online conversion link: https://www.freepdfconvert.com/zh-hans


The specific operation steps are as follows:



 ① After opening the conversion link in the browser, click the (Select File) button to upload the PDF file to be converted from the computer, and you can also upload multiple PDF files at the same time.


 ② After uploading, wait for the conversion to complete, click (Download) to download it to the computer, or save it to Google Drive or Dropbox.


 


3. ZAMZAR



 ZAMZAR Online Converter is a full-featured online format conversion tool. It not only supports converting PDF to PNG and other image formats, but also supports converting to EPUB, DOC, JPEG, CR2, CRW, HTML, ODP, TXT, PDF, CSV, DWG, GIF and other formats, even support the mutual conversion between various format files. Almost all file formats you can relate to in daily life can be converted here, and the operation is very, very simple. Additionally, you can add watermarks to documents and password-protected PDF files.


 Online conversion link: https://www.zamzar.com/convert/pdf-to-png/


The specific operation steps are as follows:



 ① Click (Add Files), upload the PDF file on your computer to convert PDF to PNG (up to 100 MB).


 ③ Click (Convert Now), after the conversion from PDF to PNG is completed, you will get a PNG file. Finally, click (Download).


 


4. pdf-online.com



 PDF Online is a multifunctional PDF conversion tool that can convert and edit PDF files. In the conversion function, you can convert PDF to PNG, TIFF, JPEG, GIF, JBIG2, JPEG2000 image formats. In addition, the website also provides some PDF editing tools, enabling users to modify and optimize documents freely.


 Online conversion link: https://www.pdf-online.com/osa/pdf2img.aspx


The specific operation steps are as follows:



 ① Click (Select File) to upload the PDF file; click (load PDF) after uploading.


 ② Then select Convert to (PNG). You can set the image quality, color and PDF conversion page after conversion, and click (Apply…) after setting. After the conversion is complete, click (Save As…) to save it to your computer.


 


5. onlineconvertfree.com



 onlineconvertfree.com is a free online conversion tool, you can convert PDF to PNG and other formats online for free. The online service works in any browser and operating system (Windows, Mac and Linux) and also has no file size limitations and no registration required.


 Online conversion link: https://onlineconvertfree.com/zh/convert-format/pdf-to-png/


The specific operation steps are as follows:



 ① Open the conversion link in the browser, click (select file), and upload the PDF file to be converted.


 ② After uploading the file, click (Convert), wait for the conversion to complete, and download the file locally.


 





IV. Other common PDF editing operations



 In addition to the above-mentioned PDF format conversion operations, you may also need to edit PDF files. The commonly used PDF editing operations include merging, splitting, adding watermarks, and rotating. In order to finish editing more efficiently, it is recommended that you use Renee PDF Aide. This software is a collection of various editing functions, among which the “PDF Toolset” module can already meet most of your editing needs.
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 After you download and install Renee PDF Aide, open it. Then click to enter the PDF toolset. In the function menu bar at the top, you can select any function to perform personalized editing operations on PDF files. Such as repair, optimization, split, merge, rotate, encrypt/decrypt, watermark, image to PDF. In addition, you can also edit multiple PDF files at the same time, batch operations, convenient and fast.


 



 Description of PDF toolset editing function modules:Repair: Repair damaged or unopenable PDF files.
Optimization: Optimize PDF files that take a long time to load, and compress large PDF files.
Split: Split a multi-page PDF file into multiple files or one as required.
Merge: Merge and output multiple PDFs into one PDF, and you can also specify the pages to be merged.
Rotation: Adjust the display angle of the PDF file.
Encryption & Decryption: You can encrypt PDF files or decrypt password-protected PDF files.
Watermark: Add foreground watermark/background watermark to PDF files, watermark can choose picture or PDF document.
Image to PDF: You can choose to merge and convert images into one file, or generate a PDF file from one image.
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